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Limitation on Warranties and Liability

All implied warranties concerning this manual and media,
including warranties of merchantability and fitness for a
particular purpose, are limited in duration to ninety ( 90 )
days from the original retail purchase of this product.

Spider Island Software does not make any warranty or
representation, either express or implied, with respect to the
software described in this manual, its quality, performance,
or fitness for any particular purpose. As a result the
software is sold “as is”: the purchaser assumes the entire
risk as to its quality and performance.

In no event will Spider Island Software be liable for direct,
indirect, special, incidental or consequential damages
resulting from any defect in the software or manual, even if
they have been advised of the possibility of such damages.
In par they shall have no liability for any programs used
with Spider Island Software products, including the costs of
recovering or reproducing these programs or data.

The warranty and remedies set forth above are exclusive
and in lieu of all others, oral or written, express or implied.
No Spider Island Software dealer, agent, or employee is
authorized to make any modification, extension, or addition
to this warranty.

Some states do not allow the exclusion or limitation of
implied warranties or liability for incidental or
consequential damages, so the above limitation or
exclusion may not apply to you. This warranty gives you
specific legal rights, and you may also have others that vary
from state to state.




Apple Computer, Inc. ( "Apple" ) makes no warranties,
express or implied of merchantibility and fitness for a
particular purpose, regarding the Apple Software. Apple
does not warrant, guarantee or make any representations
regarding the use of the Apple Software in terms of its
correctness, accuracy, reliability, currentness or otherwise.
The entire risk as to the performance of the Apple Software
is assumed by you. The exclusion of implied warranties is
not permitted by some states. The above exclusion may not

apply to you.

In no event will Apple, its Directors, Officers, Employees
or Agents be liable to you for any consequential, inicidental
or indircet damages ( including damages for loss of
business profits, business interruption, loss of business
information, and the like ) arising our of the use of inability
to use the Apple Software even if Apple has been advised
of the possibillity of such damages. Because some States
do not allow the exclusion or limitaion of liability for
consequential or incidental damages, the above limitations
may not apply to you.




Copyright Notice and User License

This manual and the software ( computer programs )
described in it are copyrighted by Spider Island Software,
with all rights reserved. Under the copyright laws, this
manual or the programs may not be copied, in whole or
part, without written consent of Spider Island Software,
except in the normal use of the software or to make a
backup copy. This exception does not allow copies to be
made for others whether or not sold, but all of the material
purchased ( with all backup copies ) may be sold, given, or
loaned to another person. Under the law, copying includes
translating into another language or format.

You may use the software on any computer owned by you,
but extra copies cannot be made for this purpose. For some
products, a multi-use licence may be purchased to allow the
software to be used on more than one computer owned by
the purchaser, including a shared-disk system.

Information in this document is subject to change without
notice and does not represent a commitment on the part of
Spider Island Software. The software described in this
document is furnished under a license or non-disclosure
agreement. The software may be used or copied only in
accordance with the terms of those agreements. It is
against the law to copy TeleFinder on tape, disk, or any
other medium for any purpose other than the purchaser’s
personal use.



PERMITTED USES

Spider Island Software grants you a non-exclusive license
to use the software according to the terms set forth below.
You may:

 Operate TeleFinder Pro software on one computer at a
time.

« Make on backup copy of the software, which
automatically becomes the property of Spider Island
Software, and is subject to this agreement.

PROHIBITED USES

You may not:

+ Copy or distribute copies of the software to others.

« Reverse-engineer, disassemble, decompile or make any
attempts to discover the source code to the software.

« Translate or create derivative works based upon the
software or user documentation.

« Remove, obscure, or alter any notice of the copyright,
or other proprietary rights related to the software.

+ Operate the software on more than one computer at a
time.
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TeleFinder™ Pro

Getting Started with
TeleFinder™ Pro

About TeleFinder Pro

TeleFinder is a Macintosh® application that allows you to connect to other
computers using a modem and your phone line. TeleFinder Pro provides
three methods of connecting with other computers: As a TeleFinder
client, a Remote Access Host, or through TTY terminal emulation.

With TeleFinder Pro you can access TeleFinder Group Edition Bulletin
Board systems around the world that provide electronic mail, group
discussions, and file sharing. You can also connect to other users of
TeleFinder Pro to share files.

As a Remote Access Host you can provide controlled access to files on
your hard disk to other users of TeleFinder Pro.

Using TTY terminal emulation TeleFinder Pro can link you to a number of
text-based commercial and public services like CompuServe®, GEnie™,
Delphi and others.

How to use this Guide

This guide is grouped by the functions of TeleFinder Pro: Installation,
Connecting to Other TeleFinder Systems, File Transfers Electronic Mail,
Participating in Conferences, , Remote Access, Using Terminal Emulation
and Macros, Miscellaneous, and Advanced Modem Settings and Trouble
Shooting.
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Installing the Software
The files you need to install with TeleFinder™ Pro can be found on the
“TeleFinder™ Pro Disk”.

TeleFinder™ Pro disk
2 items 636K in disk 149K available

[ECI== T1elefinder™ Pro Folder |

[ s items 636K indisk 149K available
_ )
F ©

TeleFinder™ Pro  TF Pro Prefs

E ~ -

. =
Read Me First Addresses  TF Outbox TF Pro Setups S

Q] =

Copy the “TeleFinder™ Pro Folder” onto your hard disk or onto another
floppy disk. The “-Read Me First-" file may contain corrections and
additions to this document.

About the Files
« TeleFinder™ Pro is the application file.

-

TeleFinder™ Pro

« TF Pro Prefs is a file that contains user preference resources.

=

« Addresses is a file that contains names and phone numbers of TF Pro P
other users for use in sending Electronic Mail.

efs

-

'
AW .-

« TF Pro Setups contains modem specific settings and command

. . g e Addresses
strings that TeleFinder uses to “Initialize” the modem.

I=a
sl

« TF Outbox is a file TeleFinder uses to send mail that was prepared  TF pro Setups
“offline”.

(g

System Requirements TF Outbox
Any Macintosh model 512KE or above, and System Software 4.1 or

later. When using MultiFinder or System 7 a minimum of 768K of

memory is suggested for TeleFinder Pro, and total system memory of

IMb or more.
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A 1200 bps or faster modem which uses the AT command set is required.
When using V.42bis or MNP a “high-speed, hardware handshake” modem
cable is required for flow control.

Configuring TeleFinder for your Modem

Open the “TeleFinder™ Pro” application. As TeleFinder opens, it
configures itself to the Macintosh you are using and builds a replica of
your desktop.

" & File Edit Special Mail Windows 539 PM,
=———— Modem Port == oo

Spider Si s=1 Rusty Tucker K] m
Spider via Hayes 730-5785 Jim White E

Spider via 12500 730-5785 Jim White
3=0 Jim White

=0 Rusty Tucker

prderbib
SpiderT2500/Rusty 730-5785 Rusty Tucker . —
1| Teleport>Spider 730-5785 Rusty Tucker 12 [T Remove

77 PRssword:

. Dial |  [inncei]  @Tone dial [ Modem Audio

| Call Progress. O Pulse dial

The TeleFinder desktop. TeleFinder's desktop includes specialized icons in addition to
the icons Finder uses. TeleFinder's Auto-Dialer is also visible.

After opening TeleFinder will normally open the “Modem Port™ icon to
access the Auto Dialer. This is controlled by a user preference which is
explained later in this chapter.

The Auto-Dialer opens the selected serial port and provides access to the
setups list which contains your Name, Password and Modem specific
information. Once your information has been entered you only need to
click in the “Redial” or “Dial” button to connect to a TeleFinder Host.

Automatic mail delivery and pickup with a TeleFinder BBS requires that

your password is also entered as part of the configuration. Fully automatic
logons to text-based ( terminal emulation ) services need a linked script.
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Choosing a Different Serial Port

If your modem is not connected to the Modem Port on your Macintosh

select “Change Ports...” from the “Special” menu.

E===———= Serial Port Selections &HFieQF eF=—

port name max bps status

:| Modem Port 57600 free

Printer Port 57600 free Y
TelePort 2400 free

D Modem 1 Slot B 19200 free

=

m. Mail Windows

v ZModem
HMODEM-CRC 1K
HMODEM-CRC
HMODEM
REK-RUEAD

Hang Up HH
Remote Access Host
Change Possword
Session Time

Preferences...

Show Partial Files... %\

The Serial Port Selection dialog lets you choose from connections through
the built-in serial ports, or through serial ports and modems registered with
the Macintosh “Communications Toolbox”. Hilite the port your modem is
connected to, and click in the OK button. The “Modem Port” icon on your

desktop will change to new port icon.

User Preferences

You can use the preferences dialog to control the way TeleFinder behaves
in certain circumstances and how it draws the replica desktop and icons.

Preferences
[JPlay Sounds.

[Jopen the “auto dialer” when TeleFinder opens.
[Q Remind me to save messages | read.

[J]0pen the Terminal when TeleFinder opens.

TeleFinder Desktop
[ Hide TeleFinder Desktop when in background.

O Arrange desktop icons where Finder puts them.
@ Arrange desktop icons on the right side of the screen.
O Leave desktop icons in their volume window.

[CJFill color icons

Desktop Font

Size : Font: [ Geneva w] (Cancel ] [ ok |

The preferences dialog controls user specific features.
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TeleFinder™ Pro

Play Sounds : When this is selected TeleFinder will play sounds
provided for specific events such as connecting, canceled file transfer or
hanging up the phone.

Open the "Auto Dialer” when TeleFinder opens : When this is
checked, the Auto Dialer will open using the selected serial port when the
TeleFinder application is opened.

Remind me to save Messages I read:: When this is checked,
TeleFinder will prompt you to save mail and text files you open on the
BBS to your own disk before closing them.

Desktop Icons
These buttons control the placement of file and folder icons on
TeleFinder’s desktop replica; and the appearance of colored icons.

Where Finder puts them. .. If this is selected TeleFinder will display
file/folder icons out on your desktop in the same position that Finder uses.

On the right side... When this is selected file/folder icons will be
organized in columns on the right hand side of the desktop.

In Volume Window... When this option is selected icons will not be
drawn on the desktop but will appear in the window of the disk they are
on.

Fill Color Icons : When this is checked TeleFinder will draw icons
- with the color “filled in” instead of color on the edges. This option
appears only on Macintosh computers with color QuickDraw.

Desktop Fonts

These Pop-up menus let you select the Font and Font Size that is used in
the windows of your folders.
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Connecting to Other
TeleFinder Systems

This chapter takes you through the process of making a connection to a
TeleFinder BBS, or to TeleFinder Pro, and introduces you to some of the
services which may be available to you on a TeleFinder BBS. See the
terminal emulation chapter for information on connecting with
commercial services and text-based BBS's

Once you have installed TeleFinder™ Pro on your Macintosh and have
customized your modem setups making a connection to a BBS or Remote
Access Host requires only the click of a button!

Each entry in the Auto Dialer’s list contains phone number, name,
password and modem setting information necessary to make a connection
to the desired service.

[f0==———————======= Modem Port m‘

' ‘ﬁ Remove I
iF Password:| essee
(Coiar_} L @ Tone dial [ Modem RAudio

Call Progress: QO Pulse dial

Hayes 2400 1714 730-5785 Guest
Hayes Ultra 1 714 730-5785 Guest
Haues Ultra- alternate 1 714 730-5735

Hayes YV-Series settings 1 714 730-5785 Guest
Hayes YSeries-alternate 1 714 730-5785 Guest
Microcom MNP strings 1 714 730-5785 Guest
minimum 2400 strings 1 714 730-5785 Guest

The file provided with TeleFinder includes settings for several popular modems. You can
use these to construct your own custom setups.

Making Changes to a Setup

From the Auto Dialer window you can make changes to the supplied
entries. For example you can enter your name and password in an existing
setup or create a new setups when necessary.
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Modem Setup Button Functions
These buttons in the Auto Dialer window manage entries in the TF Pro
Setups file.

Add: Adds a setup to the file.
Edit: Opens an edit dialog for the selected setup.
Remove: Deletes the selected setup from the file.

To enter your name and password select the setup for your modem and
click in the Edit button.

=—————— Setup Update =

Connection Name Host Phone Number
Iﬁages Ultra | [1 714 730-5785 |
Link 10 Macrn: X TeleFinder™ Host? [ Supports Mail?
User Name Password
IGuest ] r ]
Flow Control: [_CTS/DIR Con... ¥ X Adjust BPS  [JUse “AT” Pacing
Baud Rate: [ wake-up with “Break”
Modem wake-up
[aTaF |
Modem initialization
Ii-[ J [ Cancel l 0K '

The Setup Update window is used to make changes to existing entries or to define new
entries. This example shows a setup used to dial the Spider Island BBS using a Hayes®
Ultra modem.

Setup Update Fields

Connection Name : This string is used to identify the entry in the
Modem Setups list. The connection name is used by the Remote Access
dialog, the Macro "DIAL" command, and the Mail Outbox.

Host Phone Number: 1s the number dialed to access the host.

Link to Macro: This button links a logon macro script to be run after a
connection is established by TeleFinder. ( Note: TeleFinder Host's are
supported by TeleFinder Pro's automatic logon and do not require a

script. )
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TeleFinder Host?: This let TeleFinder know if the Host is- TeleFinder
compatible or not.

Supports Mail?: This lets TeleFinder know if the Host supports
mailboxes ( such as Group Edition Host BBS's do ). Do not check this
box for entries used to connect to a Remote Access Host.

User Name : Is the name you use to logon to a TeleFinder BBS,
commercial service or other system.

Password: The password you provide for access (optional).

Adjust BPS : When this is checked TeleFinder will adjust its
communication speed to match the speed of the modem connection.

Use “AT” Pacing: Some modems need TeleFinder to slow the pace
of AT command strings. Check this when using TeleFinder with older
modems.

Use "Break" for reset : When this is checked TeleFinder will send a
short break signal to the modem before it initializes the modem or hangs

up the phone.

Baud Rate : The speed that TeleFinder will use in communicating to
the modem.

Flow Control : The type of flow control that will be used between
TeleFinder and the modem.

Modem Wake-up : The first string of AT Commands sent to your
modem. The modem strings are used to configure your modem for

compatibility with TeleFinder and to access advanced modem features.

Modem Initialization : This is the second string sent to your modem.
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Start Your Logon

Begin by clicking in the Dial button to call the BBS. TeleFinder will
“Wakeup” (initialize) your modem, dial the number and wait until the
modems connect. Use the Redial button when you want TeleFinder to
automatically redial a busy number.

Once the modems connect, TeleFinder will verify your name and
password, then add icons to your desktop representing services the host
has provided for you.

Connection Messages
TeleFinder will normally display the following messages in the Call
Progress field during the Wakeup and dialing process.

Waking up the modem. ..

Dialing the number-...

Waiting for an answer...

Connected at 2400 bps. (or 1200, 9600, etc.)

If you had clicked in Redial and the number was busy TeleFinder will
wait a few seconds and begin again at “Dialing the number”.

During logon the Host will verify your name, password while displaying
these messages in the Call Progress field:

Waiting for the host...

Sending name and password. ..
Waiting for verification...
Sending confirmation...
Successful connection!
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Possible Errors During Connection

While TeleFinder establishes a connection to the bulletin board a number
of errors may occur. Problems are rare, but when they occur the following
are the most common.

« TeleFinder may not be able to “Wakeup” your modem.
This normally occurs only when the selected setup does not match your
modem.

Reselect the setup from the list and try again.

« TeleFinder displays the “No Computer Answered” message and stops
dialing. This may happen if you dialed the wrong number, the BBS was
busy and could not accept your call, or your modem is not compatible with
the modem on the BBS.

Verify that the phone number is correct and try again with Modem Audio
checked. Listen to your modem as it waits for an answer. If there is no
answer, the BBS may have just lost a connection and is not ready to
answer a call yet. Wait about one minute and try again.

If it sounds like the modems try to connect, modem compatibility may be
the problem. This might be solved by changing modem strings. Please
see the Trouble Shooting chapter for more information.

« TeleFinder displays “The Host did not Start the Logon”. This occurs if
you make a connection on a noisy phone line, the cabling is improper for a

high speed modem, or if you dial a computer that is not using TeleFinder.

Verify the phone number you’re calling and try again.
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Icons Received from the BBS

After a successful connection, the BBS will send the icons that you have
access to. These will be added to your desktop on the right hand side of
your screen. You can open them just as you would a folder or a disk
icon by double-clicking on them.

" & File Edit Special Mail Windows

{ Time Connected 01:15

{ Time Remaining 43:45
Last Logon 4/30/91 1:19 PM
Host Time 4/30/91 1:38 PM

Sample screen from a “Guest” connection to the Spider Island BBS.

The screen above is an example of what you will see after connecting to
the Spider Island Software BBS. TeleFinder displays the Spider Island
Files icon to indicate access to files on Spider Island’s disk, a Mailbox
where your mail resides and a Conferences icon containing various
public messages.

Session Time
The Session Time window indicates the amount of time that you’ve been
connected and the time remaining for a given connection.

When you're connected to the latest version of TeleFinder Group Edition
you'll also see your last logon date and the date/time your current session
began. These are shown in the local time of the host you are connected
to.
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Types of Icons you may see
5 The Host may put four types of icons on your desktop. Each of these
E] represents access to a different service of the bulletin board.

can copy files found in icons like this.

Public Messages are found in icons like “Conferences”. You can
read the messages within this icon and add messages of your own.

have a letter sticking out of it when there is mail waiting for you.

E Your Mail is found in an icon like “Guest Mail”. The mailbox will

""""""" Drop-boxes are used to send mail and files to other users. You
E cannot open this icon to view its contents.

Other Types of Icons

After you open a main icon you may see three other types of icons in
addition to the icons Finder uses for files. TeleFinder can open files with
these icons without using a different application.

o Message Threads are found in icons like “TeleFinder New

— Thread”. These icons group together several messages on a related
TeleFinder News Thread topic.

Message Files are shown like “A Text File”. mail messages in
your mail box will appear like this. This is also the default icon

ol el for any text file.
o
‘A MacPaint format bitmapped graphics files have this icon.

Bitmap Graphic
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Document Icons

Documents from other applications will be shown with their own icons if
they are included in your desktop file. If your Finder does not know about
a certain type of icon the generic default icon will be shown.

d E

A Stufflt Arhive sit = A MacWrite |l document
A Compactor Archive.cpt

You can use “Get Info” to find size and related file information about a file
and to retrieve its comment.

A “TeleFinder Message” may also appear on your screen. It is used for
welcome messages and for special or important announcements. It usually
appears only if it has changed since your last call.

SCJ=———=—== Telefinder Message... =——————|

Welcome to Spider Island Software. Home of
TeleFinder™ Group Edition for the Macintosh®.

Longer messages will appear within their own text window. These
messages may contain up to 32K of text and can be saved, printed, and
later edited like any other text file.

Accessing TeleFinder Services

With TeleFinder BBS’s it is customary to provide a “Guest account with
limited access for new users. The person operating the BBS can usually
receive mail addressed to “Sysop”. A letter explaining the purpose and
customs of a specific BBS can usually be found in the Guest Mailbox.

You can call the Spider Island BBS to download a list of publicly operated
systems using TeleFinder. Many of these systems provide business related
services. For example:
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Using “Get Info”
To open Info for a file hilite its icon and then select “Get Info”” from the
file menu. Get Info operates with both local and remote files.

F—————— Info §I

E E] fanked

=
=] TF User 2.12.cpt

Kind: document, (PACT)
Creator: CPCT

Size: 427,661 bytes.

Yhere: Group Edition 2.1 Files, 7,642 K
bytes free.

Created: Thu,Oct 11,1990 5:52 &M
Modified: Wed, Dec 19, 1990 10:20 &AM

##* Includes version 2.12 of TeleFinder /User .
Requires Compactor and TF Updater 1.02.

In addition to basic file information the Info window displays the file’s comment. The file
comment can provide you with important notes about the purpose or use of the file.

Use the Receive button to transfer the file to your default destination. You
can change the file comment on files from your own disks. Any comment
included with the file will be retained during file transfers.
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File Transfers

Transferring Files

File transfers between TeleFinder Pro and a TeleFinder Host are started
using the same click and drag techniques that you use with Finder to copy
files from one disk to another.

& File Edit Special Mail Windows 208 P e

Guest Files
2 Remote {1

-

Te n ClockSynchS sit berCard Folder Games & Fun

E=— utilities =—=p%|
2 Remote Sig

nrms«am
n SetClock 2.0 sit
n Spy!sit

n Stuffit Cataloger 1.0.sit

@ UnStuffit 1.5.1

In the example above, the user is transferring the “Ram Disk+ 2.11.sit” file to their disk
called “Macintosh HD" from the Ultilities folder, by dragging it to the hard disk icon.

Sending Files

You can send files directly to a Host’s “New Uploads Folder”, to another
user via their Drop-Box icon by dragging their icons to the appropriate
destination icon. To receive a file from a Host, drag the file’s icon to one
of your folders, disks or to the receive icon on TeleFinder's desktop.

To a Host’s “New Uploads Folder”

To send one of your files to the “New Uploads Folder”, drag that
document’s icon to the “Send” icon at the bottom of your screen. A short-
cut is to double-click the “Send” icon to use the “Open” dialog to select a
file to be sent. After it is sent, there will be a copy of your document in
the designated folder on the bulletin board system.
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To another User’s Mailbox

When you want to send a document directly to another user, you will need
to first get that user’s drop-box icon. To do this, choose the menu item
“Get the Drop-box of...” from the Mail menu. Enter the users name and
click OK, the Host will then send you that users drop-box icon and put it
on your desktop.

Drag the icon of the document that you want to send to the drop-box and
TeleFinder will send a copy of it to the user’s Mailbox. When that

user connects to the Host, they will see the “letter” in their Mailbox ﬁ
icon indicating that mail is waiting for them.

Drop-box icons can be double-clicked to use the “Open” dialog for
selecting a file.

Receiving Files

You can copy (download) a document or application from the Host system
to your disk, folder, or network file-server whenever you are connected to
the Host.

From the “Info”” Window

Click on the Receive button in the file’s Info window to begin the file
transfer to download the file to your default destination. For more
information on the Info window see “Using Get Info” in the previous
chapter.

From any Host Folder or Mailbox

You can always copy the documents located within your mailbox by
dragging them to your disk. Delete mail after you have copied or read it by
dragging it to the Trash icon. You cannot delete files from Download Files
Folders.

Default Receive Destination

TeleFinder uses the “Receive” icon located on your desktop to represent
the “default destination” that may used when receiving files. Files can be
dragged to this icon instead of a disk or folder icon when copying
documents from the host.
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Open the Receive icon to select any folder as your default destination. In

this example, a folder named “TF Pro Folder” has been selected.
@ You can also drag a folder from one of your disks to the Receive
r 1 icon to make that folder the new default destination.

 Spider 100 ¥

O Masters | < Spider 100
O Other

0O PageMaker 3.0 Eject

O Programming o

O Public Files
0O removed INITs ——

DO System Folder
O TF Pro Folder ——
O stesting thread

Select receive folder: Select this Disk

Use this custom “Open” dialog to select a file or disk to use as the default destination.

Batch File Transfers

Using TeleFinder a group of documents can be sent or received at the
same time. Select the group of files and drag them to their destination.
You can select them all at once by drawing a selection rectangle around
them, or by holding the shift key down while you click on individual
icons.

File Transfer Protocols

TeleFinder supports XMODEM, XMODEM-CRC, XMODEM-1K and
ZMODEM file transfers. Before you send or receive a file, you can select
the file transfer protocol you wish to use from the Special Menu.

ZMODEM

ZMODEM file transfers have the advantage of 32 bit CRC's and file
recovery. The capability to perform file recovery is one of the reasons
ZMODEM is often called an “intelligent” protocol.

TeleFinder's implementation of ZMODEM automatically adapts packet
sizes in response to baud rate and line conditions.
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Flow Control and ZMODEM

ZMODEM achieves faster file transfers by continuing to send data until
the transfer is complete or the receiver requests a re-transmit. The non-
stop nature of the protocol requires flow control to balance the speed of
the sender and receiver.

If hardware flow control is not in use TeleFinder will automatically turn
on XON-XOFF flow control to balance the transfer speed.

When using ZMODEM with error-correcting modems ( MNP, V.42 and
others ) it is necessary to use “CTS/DTR” flow control and a “hardware
handshake” modem cable. Hardware flow control can balance the flow of
data between the computer and the modem.

XMODEM

The XMODEM file transfer protocol uses less overhead than ZMODEM
and does not require flow control. You may want to select XMODEM
when you have a large number of small files to transfer. XMODEM does
not support file recovery.

TeleFinder supports 3 variations of XMODEM file transfers. Original
XMODEM with checksum error detection, XMODEM-CRC with 16 bit
CRC error detection, and XMODEM 1K with 1K byte data packets and 16
bit CRC.

In addition, the "Ack-Ahead" option can be selected for faster transfers
only with error-correcting modems. Although Ack-Ahead will speed up
an XMODEM transfer, it will also prevent XMODEM from completing a
transfer if a data error occurs.
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The File Transfer Dialog

A status dialog is opened during a transfer to keep you up-to-date with its
progress. The key points of information displayed in it are explained
below.

ZMODEM Status Si—u—
Receiving File J
TF/User 2.1 Demo.cpt
Transfer Time: 00:06
Thru-Put:5,866cps
Received: 35,200 bytes
Size: 210,635 bytes

Timeout Secs: 10.0
Re-Transmitted: 0
Timeouts: 0

Receiving with Macbinaryand 32

«  Receiving File - This is the name of the file that it is being sent or received.

«  Transfer Time - A count of how many minutes and seconds have elapsed since the
transfer was started.

«  Thru-put - This tells how many valid characters-per-second have been sent or
received. Thru-put is reduced when retransmits are necessary for error correction.

«  Received - The total number of good bytes received.

«  Size - The total size of the file being sent or received

«  Time Remaining - This provides an estimate of the amount of time the transfer will
require to complete. The field is initially "9999" until the Macbinary information has

been received.

«  TimeOut Secs - This is how long the program will wait for an packet
acknowledgement from the receiver, or the next packet from the sender.

«  Re-Transmitted - This is the total number of packets that were requested to be re-sent
due to error corrections or timeouts. TeleFinder will cancel a transfer when a packet has

been resent unsuccessfully 10 times.

«  Timeouts - The number of times that the timeout period was exceeded during
transmission or packet acknowledgement.
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Canceling a Transfer

To cancel a file transfer in progress click in the Cancel button. TeleFinder
will clean-up any actions in progress, send a cancel message to the host
and wait for a “ready to continue” message to be sent back from the host.

When a ZMODEM transfer is canceled, a record will be added to the “TF
Pro Partial Files” document so that the transfer can be completed at a later
date.

[EE————o——— Partial ZMODEM files |

From File Name Where

T Ty T I R LT L OO | [

Pct Complete: 32 % Size on Disk: 46K
Last Changed: 4/30/91

The Partial ZMODEM File window displays information about partial files saved on your
disk. This dialog is opened using the “Special” menu “Show Partial Files” item.

ZMODEM File Recovery

If a ZMODEM file transfer fails to complete, TeleFinder records .

the partial file so that the transfer can be completed at a later time. '

The “Disk First Aid” Icon to the left shows the icon used to display Disk First Aid
partial files.

To complete a partial file, drag the file to the same location to resume the

transfer. This method can be used to complete transfers of files that you
have tried to send or receive.
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Electronic Mail

The TeleFinder mail system is managed on a TeleFinder BBS using tools
provided with the Group Edition Host program, and by functions within
TeleFinder Pro.

Get the Drop-Bow of... %D
Chat Messenger... EM
Locale a user... ®U
New Messane Topic =y
New Mall Form ®N
Heply 16 Mail =h

The Mail menu provides access to the basic functions of TeleFinder's electronic mail.
This menu is not active when connected to a text-based service or another copy of
TeleFinder Pro.

The “Mail Outbox™ can be used to queue files and messages to be sent at a
predetermined time, or to pick up your mail for you. “Addresses™ can be
used to maintain a list of frequently used names.

L

The “Addresses” and “Mail Outbox" icons provide ways to automate the process of
sending and receiving mail.

TeleFinder sends mail to other users through a “Drop-Box™ icon. This
icon gives you write-only access to another user’s mailbox. When mail
has been sent to you it will be available inside of your mailbox icon.

by

The “Drop-Box” and “Mailbox” icons for the Guest account are shown above. A Mailbox
icon with a letter in it indicates that mail is waiting for this user.
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The Mail Form

The mail form is a convenient way of sending a text message to another
user. It is most useful for short messages that you want to enter while you
are still connected to the Host.

Creating a New Message
Choose “New Mail Form” from the Mail menu to open this window:

[ To. JGuest Date 6/1/909 10 AN
From: Rusty Tucker
Subject: Welcome to Spider Island Host

welcomel we're pleased you logged-on to our system to look at (]
TeleFinder™/User for the Macintosh

The mail form uses the standard Macintosh text editing commands
including Undo. You can address the message by clicking in the To
button and selecting a name from your address book; or by simply
entering a user’s name in the field to the right of the button.

If you are on-line, the Mail button at the bottom of the window will be
active and will transmit your message as soon as you click on it.

Using the “Print”, “Save”, or “Save As” selections from the File menu the
Mail window can be printed, or saved on disk.

Replying to a Message
When you have received mail created with the Mail form, you can reply to
it by making the original message the front window and then
selecting the “Reply To Mail” menu item.

Get the Drop-Box of... %D
Chat Messenger... M
Locate a user... ®U
New Message Topic
New Mall Form
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Locating a User

When sending mail it is necessary to know the exact spelling of the
recipient’s name in order to properly address your message. The “Locate a
User” function can help you find valid addresses for your mail. You may
save them in your local address book for quick reference in the future.

Locate a user

Enter a part of the persons name you
are trying to locate.

( leave blank for all names )

IJohd J
(cancet] [ ok

You can either enter a portion of a user’s name, or leave the entry blank to
receive a full listing. When you enter a partial name, the host will send
you a list of all the names that contain that string. The name search is not
case sensitive.

Located Users List

The User List that is created by the “Locate a User” function can be used
to place a user's Drop-Box on your desktop with the Mailbox button, to
copy their name to the clipboard with the Copy button, or to save their
name in your address book with the Save button.

E—————————————== User list ==iF""= —
User Name User Info Last C ¢ L‘]‘Mollbou
John Blackburn 1'!} e o ]
John LaBriola '3",2“‘7'm -

Pete = 8/9/89 Copy
Pete Johnson ______________________c.oo0 |

~

7]

In some cases the “User Info” field may have a phone number or company
name for reference. The “Last Connect” field shows the last time the user
logged on to the BBS.
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Mailing a File to another User

To send a document you need to have the recipient’s Drop-Box icon on the
desktop before you can send them a file or message. You can tell the Host
to put a Drop-Box on your desktop in any one of three ways.

« You can click in the Mailbox button in the User List window created
by the “Locate a User” function when the User’s name is hilited.

* You can click in the Mailbox button in your address book window.
A variation of this is to use the “Auto Drop-Box™ feature of the address
book to retrieve the Drop-Box every time you connect.

« Or, use the “Get the Drop-box of...” function from the Mail menu
and enter the user’s name.

To send a file to this person drag the file’s icon onto his Drop-Box icon
and TeleFinder will copy it into their mailbox.

Your Address Book
Your Address Book is used to store the names of other user’s of your host
and their phone number (optional). The address book can automatically

“get the drop-box” for users entered in it each time you logon. In addition,

these names are used by the “Outbox’ and “Mail Form” when addressing
your mail.

User Name User Info  Auto Dropbox Mallbnu
nu,i Hada 0582-51-2101
ete Johnson . CUD!I
Rusty Tucker
nuu
I Change
uu Remove

With the User Name selected, the Addresses window buttons become active. Open the
Addresses icon to open this window.
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Address Book Buttons

« Mailbox - If you are connected to the host this button puts the Drop-Box
of the selected user on your TeleFinder desktop.

« Copy - Copies the selected name to the clipboard. Once on the
clipboard, it can be pasted as text into other documents.

« Add - Brings up the dialog used to add an additional user name to your
address book.

« Change - Brings up the dialog used to change the name, phone number,
or Drop-Box option for the selected entry.

« Remove - Deletes the selected entry from your address book.

Changes to the Address Book are automatically saved when you close its
window or quit TeleFinder.

Adding or Changing Addresses
Click in the Add or Change button to bring up the “User Address” dialog

to edit user entries.

=——= User Address ==
User Name

lhusty Tucker 4]

Phone Number

[714 669-9260 |

X Automatic Dropbox

User names are limited to 31 characters. The phone number field is
optional and is limited to 19 characters of any text.

If “Automatic Dropbox” is checked, the user’s Drop-Box will be put on
your TeleFinder desktop each time you connect to your Host. The small
mailbox icon appears in the Address Book when the Automatic Dropbox
option is selected for that user.
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Automated Mail Delivery and Pickup
With the Mail Outbox, TeleFinder can be configured to pickup and deliver
your mail while you are away, or doing something else.

The “TF Outbox” file contains information from the Address Book, TF
Pro Setups, and the location of files on your disk to construct an internal
script that TeleFinder follows to send and receive mail.

Em=——— — LM
Send files:

@ Neut connect O At:

(& Pickup my mail too!

Files to send:
To Filename ﬂdd

Rusty Tucker 1e> Meeting Wednesday ’ Edit
aSaua

ﬂemove

Up to 250 files can be scheduled by the outbox.

Outbox Buttons
* Next connect - TeleFinder will prompt you to send files when you

select Hang Up. or Quit to end your connection with the BBS. After your
mail is sent TeleFinder will continue and hang up the phone.

» Ar: - When you have selected “Send Files At:” TeleFinder will call

the BBS at the time you have selected. TeleFinder must be open at the
time to do this.

* Send Now - TeleFinder will call the BBS if necessary and send your
files. If you are already connected it will just send your files, then
disconnect from the Host when finished.

* Pickup my mail too - With this selection checked TeleFinder will
download mail from your Mailbox into your default receive destination
after sending any mail in your outbox. Mail that is successfully received
will be deleted from your Mailbox.
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« Host >> - Selects a TeleFinder Host setup from your TF Pro Setups
file to be used when calling the BBS.

« Add - Adds a file with an address to your Outbox.

« Change - Changes the address of the selected file.

« Save - Saves changes to your Outbox on your disk.

« Remove - Removes the selected entry from your Outbox.
How to Configure your Outbox
Click in the Host button and select the setup for the host you want to send
to (only setups for TeleFinder Hosts with Mail Systems will be visible in

this list). If you want to send mail at a later time, this setup must include
your name and password in addition to the modem specific information

Select a Host

Host connection setups

Spider S|

Spider via Hayes
Spider via 72500
spider/jim
spiderbbs
SpiderT2500/Rusty

We've selected "spiderbbs” in this example to provide initialization, name and password
information from this setup for use by the outbox.

When you click the Add button in the Outbox window, the “Open” dialog
is presented for you to select the file you want to send. We're adding “re>
Meeting Wednesday” in this example. Select the file you want to send and
then click in the Add button.

Next, you’re prompted to select or enter a user to send the file to. You can
either double-click to select one of the names listedfrom your Address
Book or enter a name in the field at the bottom and then click OK.
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Selecting a Time to Mail

Once you have selected all the files you want to mail, you can choose to
send them now, or click the Send Files At button and the Date/Time Set
dialog will appear.

[E=== poate/Time set ==
Send my mail at:

Hour  Minutes O aM

o | o

Month Day Year

5 I 29 l ||990
Lo

Enter the date and time that you want the connection to be established and
TeleFinder will place the call to the Host, perform its assigned tasks and
log-off.

Note: TeleFinder must be open at the chosen time. It cannot launch itself
to send or pick-up your mail.

Waiting to Send at the Next Connection

If you choose to wait and send your mail the next time you connect to the
Host, TeleFinder will prompt you to send the files before your Quit or
Hang Up the phone to disconnect from the host.

Do you want to send the
items in your Outbox before
Hanging Up?

Clicking in the Yes button will send the files in your Outbox; No will skip the Outbox and
Hangup the phone; and Cancel will leave you connected to the host without sending your
files.

Clicking in the Send Now button while connected to the host will
immediately send the mail from your Outbox and then disconnect.
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Participating in
Conferences

Conferences are the electronic version of the common index card and
thumb tack bulletin board. Conferences are primarily used to organize the
message threads on the BBS.

o The message topic, or message thread, document
= can contains several messages on a related topic
TeleFinder News Thread available from one icon. As a BBS user you can

reply to existing messages, or create new topics in a conference.

~

pecial Mail Fu

& File Edit Mode

Conferences —

Conferenoce

;E

Service Bureau Forum

2

TeleFinder Questions

K

message topic icons.

Opening a message icon displays the viewer window that you use to
navigate through a topic to read messages of interest to you.
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Viewing Messages

The message viewer window contains buttons to navigate through a mes-
sage base, remove messages that you have sent, and reply to a given mes-
sage. Only the sysop or the person who originally posted a message can
remove a message from the message base.

[EDJ=—=—————————== Hordwore Handshoke |

To All Date: 4/30/91 S5:42 PH
From: Rod Paine
Remove Repl
Subject: RE>Handshake ﬁﬁ J |E ply I

Hayes ULTRA or U-series modems with RTS/CTS hardware handshoke cable.

® Use ATEF as initialization string
® 38.4k bps Baud Rate Setting (0600 bps for U2400 U-series>
o Adjust BPS on

® CTS/DTR Flow Control

Mac DIN 8 Modem DB25
Pin Pin
HSKO | =—=—————————— > 4 RTS
HSKi 2 ¢====mmmeee—— 5§ CTS
™0 3 ————=> 2 TxD

Seleclr#ﬂy Number "_9,,89 Date “E From lisll O 107 10 [:>

Conference messages can be saved as text files, or printed from the File menu.

Message Base Navigation

When you first open a topic you will be positioned within that topic based
on the date that you last read messages. The right arrow will display new
messages, and the left arrow will display older messages. The current
message number is displayed between the arrows.

Selecting a Message By Number

The Select By Number button can be used to display a specific message
number in the viewer window. To select a given message by number click
in the By Number button and enter the number of the message you want to
read in the “Get Message” dialog.

Get Message |

Go to message number

If the message number that you enter is not available because it is too high, or too low you
will be positioned to the last message or the first message.
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Selecting By Date

If you want to see messages posted starting with given date and time, click
in the By Date button and select a starting point with the Date/Time Set
dialog. Once you are positioned to the chosen Date, you can again use
the arrow buttons to navigate forward or backward within the thread.

Selecting Messages from a List
The From List button allows you to “'scan” a group of messages. The
button brings up a dialog asking for a message number starting point.

Eme——— — Bune—— ——————

Subject Mail Form i
To ALL E
From  Rusty Tucker

Msg® 27 Size 1711
Date 5/4/90 11:01 PM

]

The “Scan List” window gives a brief on each message including it subject and size. Click
on the subject area to read that message.

Each scan collects up to 10 message headers. Use the scroll bar to see
information on each message. When you want to read one of the messages
click on its subject area in the middle of the window.

The Prev button will scan the 10 previous messages prior to the first one

in the current list. The More button will scan the next 10 messages after
the last message in your current list.
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Replying to a Message
Click in the reply button to open a new message form. The Reply window
gives your the option of have the option of making your message public or

private.

EIS=————=—=Reply To> Miil form

[[3 To. JRusty Tucker Date: 5/7/90 4:20 PM
From: Rusty Tucker X
Subject: Mall Form
©]
PMail | [4Post ]

Your reply can be private ( to the original authors mailbox ), or public ( posted within the
Message Thread ).

Reply Buttons
* Mail - Your message is sent only to the author of the message you

are replying to.

* Post - Your message is made public as the last message in the thread
you are replying to.

* To - Can be used to address your reply to a different person using
the same subject.

You can change the subject of your reply by editing the supplied one.
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Creating a New Topic

Bring a conference window to the front of the screen and select the “New

L)

Topic in "window"” item (“*Sysops Corner” in this ex-
ample) from the Mail menu. This will open a New
Topic window similar to the New Mail window.

Windows
Get the Drop-Bow of... %D
Chat Messenger...
Locate a user...

New Mall Form
Heply 16 Mail =H

Filling in a New Topic

The Subject that you enter will become the name of the message thread
icon in the conference you are creating the topic in. Enter ALL into the
“To” field when you don’t want to address it to anyone in particular.

After you have entered your message, click in the Post button to create
the document and message thread on the host.

Creating your Topic Offline

If you have a long message, you may want to Hang Up the phone and then
finish entering it. Then reconnect to post it into the conference using the
Post button.

As long as you leave the Reply or New Topic window open between con-
nections, TeleFinder will remember which conference to post it into.
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Using the Terminal Window
and Macros

The terminal window in TeleFinder Pro is used to communicate with
commercial services, text-based bulletin board systems and other
computers running terminal emualtion software.

=)
i}

El Terminal

Optic Send M Receive Macro Pause @ Cont @ Cancel
Hv Full Dup!
Half Duples ot
Echopler

Baud Rate...
Tent Filter...
Data Format...

v Use Macbinary

Link as TF User
Link as TF Host

TeleFinder's terminal window includes it's own pull down menu and buttons for file
transfers, macros, and flow control.

Connecting to a Text Based Service

You can connect to text based services using the Auto Dialer and a Linked
Macro to automate dialing and your logon sequence. Macro commands
can be used to access your name and password from an Auto Dialer entry.

The illustration on the following page is an example setup that is used for

dialing CompuServe with a Hayes compatible 2400 baud modem and
linked script.
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= setup lpdate ———"—————|

Connection Name Host Phone Number

[compuserve | [833-9915 B
Link to Macro: [ TeleFinder™ Host? [JSuppoits Mail?
Spider 80:TF:CIS Logon

User Name Password

P3457,2?56 I ooouonuul

Flow Control: X Adjust BPS  [JUse “AT” Pacing

Baud Rate: [J Wake-up with “Break”

Modem wake-up

[aToF

Modem initialization

rm l Cancel ] ‘ 0K !

Linking a Macro to a Host Setup makes it as easy to connect to Text Services as itis to
TeleFinder Hosts.

Linked Macros

To Link a Macro to a Auto Dialer entry the TeleFinder Host? checkbox
must be left unchecked. Click in the Link to Macro button and use the
“Open” dialog to select a macro that you want automatically run after the
connection is established.

When a Macro is Linked to an Auto Dialer entry it will be able to access
the name and password using the “SENDNAME” and “SENDPASS”
commands. When you select a linked entry and click in the Dial button
the Auto Dialer will perform the standard modem initialization and
connection routines to connect you to the remote computer.

Once a connection between the modems has been established the Auto
Dialer will open the terminal window and run the linked Macro. Several
example logon macros are included with TeleFinder to help you create
your own.

Terminal Menu

The terminal window “Options” menu provides control over
communications parameters, can select Macbinary file transfer formatting,
and provides items to Link with another Macintosh in TeleFinder's
graphical mode.
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Half Duplex
Echoplen

Baud Rate...
Tent Filter...
Data Format...

vUse Macbinary

Link as TF User

Link as TF Host

Duplex
Full Duplex - Should be selected with most systems that you will
connect to ( CompuServe is Full Duplex ).

Half Duplex - Should be selected when the remote system does not
echo characters you type ( GEnie is one example ).

Echoplex - Should be used when you connect to another computer
running terminal emualtion software. This setting will echo

characters received from the remote computer and characters you type.

Baud Rate

Opens a dialog that you can use to change the baud rate used to
communicate through the serial port to your modem. TeleFinder can
communicate at any speed up to 57,600 bits per second.

Text Filter
The text filter modifies TeleFinder's handling of characters received from
the remote computer. The default setting is off, no filtering.

Receiving Text Filter Options

X Filter text as it is received

[ Convert DEL to Backspace

End Of Line:
R

Aipha Case:

Filter text as it is received- Turn this setting on when you want TeleFinder
to perform filtering or conversions of characters received from the remote
computer.

Convert DEL to Backspace - Turn this setting on when you are
connecting to a computer that uses a Delete character instead of a
Backspace.
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End of Line - This menu allows you to convert received Returns ( CR ) to
a Return/Linefeed pair ( CR-LF ). If all of the text received from the
remote computer overwrites on a single line change this setting from “No
Conversion” to “Convert CR to CR-LF”.

Alpha Case - This menu ca be used to convert received text to all upper,
or all lower text if needed.

Data Format

This menu item opens a dialog used to define the format of characters
received and transmitted through the serial port. 8 data bits, no parity, 1
stop bit ( '8-N-1") formatting is used by most systems, but occasionally
you will need to select 7 data bits, even parity, 1 stop bit ('7-E-1") to
communicate with some mainframes and MS-DOS computers.

Data Format
Data Length Parity Stop Bits
@ 8 bits @None @ 1 Stop Bit
O 7 bits QEuven O 1.5 Stop Bits
QO bidd O 2 Stop Bits
[ ok )
e
(“save ) (cancel )

The data format dialog only affects terminal communications, TeleFinder's
User and Host modes always use 8-N-1.

Use Macbinary

This item should always be checked when you are transferring Macintosh
files to be used on a Macintosh. When you are transferring a file that will
be used on a MS-DOS computer turn “Use Macbinary” off.

Macbinary formatting is necessary to transfer Macintosh resources.
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Link as TF User

This menu item initiates a connection to a TeleFinder host in TeleFinder's
graphical user mode. This is useful when making direct connections to
another computer running TeleFinder Pro, or to a TeleFinder BBS that you
connected to from the terminal window.

Link as TF Host

This menu itemprovides a direct link to your disk(s) without name or
password checking. This is a manual way of providing remote access to a
user already connected to your computer without using the Remote Access
window.

The remote computer must be capable of “Linking” as a TF User for this
function to be successful.

Terminal Buttons

The terminal buttons are located to the right of the “Options” menu at the
top of the terminal window. These buttons perform actions that are
specific to terminal communications and are not used when TeleFinder is
communicating in it's graphical mode.

Send - This button is used to select a file and start a binary file transfer
using XMODEM or ZMODEM. The protocol used by TeleFinder will be
the one that you have selected from the “Special” menu in the menu bar.
If Macbinary formatting is desired be sure that “Use Macbinary” has been
checked in the “Special” menu. The “Open” dialog is used to select the
file you wish to be sent.

Receive - Like the send button TeleFinder will receive a file using the file
transfer protocol selected in the “Special” menu. Received files are saved
in your default folder which is represented by the “Receive” folder on the
TeleFinder desktop. Select “Use Macbinary” when you want Macintosh
files to be saved in Macintosh format.

Macro - This button opens a text file of Macro commands then interprets
and performs the commands contained in it. Only TeleFinder Pro text files
will be interpreted as macros.
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Pause - Use this button to send an XOFF character to the remote system.
An XOFF will generally cause the other computer to pause when sending
a stream of text.

Cont - Continue, use this button to send an XON to the remote system.
The XON character will cause the other computer to continue sending text
after a pause.

Cancel - Use this button to send a control - X to the remote system.
Control-X is commonly recognized as a signal to cancel file transfers or
cancel text output.

Using TeleFinder’s Macro Commands

TeleFinder’s macro language is most often used to automate a logon
sequence. Your disk has several examples that you can open, print and
edit just as you would any text file. Working from these examples is a
good way to become familiar with macro capabilities.

Logon macros are especially useful since each TeleFinder Auto Dialer
entry to text based services can be configured to run a macro whenever
you connect to it. Since the macro you use can access your name and
password from the dialing directory you may be able to use the supplied
macros without change to connect to your favorite service.

General Structure of a Macro Script

TeleFinder's macros are read in as a plain text file with lines ending in a
carriage return. This text is scanned for errors by the command
interpreter then run in real time after each statement is interpreted.

Comment lines begin with an asterisk ( * ), and commands that cannot be
interpreted are skipped after a warning to the user. While a macro is
running some of TeleFinder's menu choices will not be accessible, certain
commands may further limit user activity until they complete.
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Creating and Modifying Macro Scripts

Create a new, empty document by selecting “New Text” from the “File”
menu. Existing documents can be opened form either the “File” menu
“Open Text” menu item, or by opening a text document's icon from
TeleFinder's desktop or a folder window.

To be used as a macro, the text file must be saved as a TeleFinder macro
text file. Any text file can be saved in this format by bringing its window
to the front and selecting “Save As...” from the “File”” menu.

3 2TF/Term 2.0 ¥

O Rddresses <
0 aModem Sefups B
0 Baud 19200 Macia
0 Broken Filas

—Desktup
O (hedkDutBon.c B Teon
O LIS Logon I3

o Spider 100

] i

Save TEHT File fs: Save
[c15 Logon Macrd I | (cancer)

O MaclWrite @ TeleFinder Macro

QO TeleFinder/User (O Other

TeleFinder lets you save text files specifying different ‘owners’. This sets the creator of
the file to a type that Finder will recognize as belonging to a specific application.

Choose the TeleFinder Macro format button from this save as dialog.
These files are saved as plain text, but with TeleFinder Pro specified as the

creator.

Flow of Command Excecution
The macro ends after the last command in the file, the END command is
run, or when the user elects to cancel rather than continue after receiving a

warning from the command interpreter.

Labels are used by the GOTO, FALSE and TRUE to ndicatea point in the
macro that should be branched to. Labels must be a single word followed
by a colon, for example “StartHere:”
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AppleEvents and Macros

When a macro file is opened using Finder's Open command TeleFinder
will automatically open and run the macro file indicated by the
AppleEvent. ( Note: Only one macro may be running at a time. )

Command Description and Syntax

The following pages describe each command available from TeleFinder's
macro language and the syntax required to properly use that commnand in
a script.

Example:

COMMAND arugument

The command must be entered starting as the first word on a line without
any preceeding spaces. The command and argument are separated by a
space or tab.

Types of Command Arguments
The following are descriptions of the various parameters accepted by
macro commands.

string:

A string of ascii characters enclosed in quotation marks. Control
characters can be generated by preceeding an alpha character by a caret (A
= shift+6 ). Common control character equivalents:

M - Return

AJ - Linefeed

AS - XOFF

AQ - XON

AX - Cancel (CAN)

sample:
TYPE "The quick brown fox"M"J"
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numeric:
A string of numeric characters ending with a semi-colon.

sample:
BAUD 9600;

path:

The path argument is a string describing the location of a file. Each valid
path begins with the name of the disk the file is located on, followed by
the folder the file is located in, followed by the file name. Each name is
separated by a colon ( :).

Sample:
SENDMAC "Mac HD:My Files:June Balances"

label:
The label argument is a string describing the a branching point within the

script. Labels are often used to create loops or separate functions. Labels
within the macro must be on a separate line as a single word followed by a

colon (:).

Sample:
GOTO "ReTryDialing"

none:
Some commands do not requirea following argument.

Sample:
BELL
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Display Commands
These commands can be used to provide the user with visual feedback or
can be used as a tool in debugging.

TRACE numeric

The TRACE command is used to show or hide a debugging dialog that
shows each command as it is interpreted and run. Supply zero for the
numeric argument to hide the dialog, non-zero to show the dialog. The
dialog is hidden by default.

SHOW string

The SHOW command displays the supplied string in the progress dialog.
This permits a user friendly description of macro activity to accompany its
progress.

logon macro S6——-——

Your logon macro is running now, please

wait...

The macro progress dialog provides macro controlled information and also gives the user
the option to cancel a macro in progress. Icons can be displayed using the ICON
command.

ICON numeric

The ICON command will cause an icon to be drawn in the progress dialog.
Supply a number that matches the resource ID of the icon you wish to
display. You can use icons from the TF Pro Prefs file, the TeleFinder Pro
appication, or the System.

BELL none
The BELL command causes the Macintosh to beep or flash the menu bar
if sound is turned off.

6-10 Chapter 6, Using the Terminal Window



TeleFinder™ Pro

Flow of Execution
The order of command execution is controlled by branching due to true/
false testing or by aribtrary branching.

GOTO label
The GOTO command aribitrarily branches to the command following the
specified label.

TRUE label

The TRUE command branches to the specified label when the internal flag
has been set to true as the result of previously executed commands. This
internal flag is neither true nor false when your macro is first opened.

FALSE label

The FALSE command branches to the specified label when the internal
true/false flag has been set to false as the result of previously executed
commands.

PROMPSEC numeric

The PROMPSEC command adjusts the timeout value used by your macro
to a specified number of seconds. The initial timeout period is 15 seconds.
The timeout affects the PROMPT command.

PROMPT string

The PROMPT command scans incoming data until a portion of it matches
the string of characters supplied, or until the timeout value has been
exceeded. If a match is found the flag is set to true, otherwise it is set to
false.

PAUSE numeric

The PAUSE command idles the macro for the given time in seconds. Data
and user interactions are processed as if the macro were not running
during this time.

END none
The END command terminates the macro and returns control of the
program back to the user.
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Data Commands
These commands are used to send small amounts of character data through
the modem.

TYPE string

The TYPE command is used to send a string of characters through the
serial port to your modem. TYPE will simulate variable typing speeds if
a SLOW command has been set.

SENDNAME none
The SENDNAME command is used in linked macros to extract your name
from a dialing directory entry and send it to a host computer.

SENDPASS none
The SENDPASS command is used in linked macros to extract your
password from a dialing directory entry and send it to a host computer.

BREAK numeric

The BREAK command causes a break signal to be generated by the
current port. The duration of the break is controlled in 1/60 sec
increments by the number supplied to the command.

SLOW numeric

The SLOW command can be used to pace the speed that characters are
sent from a TYPE, SENDNAME, or SENDPASS command. The
minimum delay between characters is measured in 1/60 of a second
increments independent of the baud rate.

Any value may be supplied as an argument. Zero, or negative numbers

will result in sending data at full speed. For example. use SLOW 4; to
limit TYPE speeds to 4 characters per second.
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Communications Commands

This group of commands are used to control serial commnunications
parameters.

BAUD numeric

The BAUD command sets the baud rate of the current port to the value
supplied in bits per second. The value supplied must be valid for the
current port and be one of the following values: 300, 1200, 2400, 4800,
9600, 14400, 19200, 38400, or 57600. The internal flag is set to false if
the requested baud rate cannot be set, true if successful.

SETCOMM string

The SETCOMM command sets the data format used by the current port.
The string must have the following special format: "8N1" for 8 data bits,
no parity, 1 stop bit. Permissable data lenghts are 8, 7, 6, or 5. Parity can
be N for none, E for even, or O for odd. Stop bits can be 1 or 2. The
internal flag is set to false if ther equested parameters cannot be set, true if
successful.

DUPLEX numeric

This command sets remote and local echos to correspond to the standard
terminal menu settings. Use 0 = Full Duplex, 1 = Half Duplex, 2 =
Echoplex. The internal flag is set to false if the requested echos cannot be
set, true if successful.

FLOW numeric

The FLOW command sets flow control on the port. Values to use are 0 =
No Flow Control, 1 = CTS ( output flow control ), 2 = DTR/CTS (
hardware handshake ), 3 = XON/XOFF ( software flow control ). Note:
software flow control is not compatible with XMODEM file transfers.
The internal flag is set to false if the requested flow control cannot be set,
true if successful.
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High Level Commands
The group of high level commands provide access to large functions from
your macro.

SENDMAC path

The SENDMAC command initiates a file transfer send of the file specified
by the full pathname description. The file transfer protocol selected in the
Special menu is used.

RECVMAC none

TheRECVMAC command initiates a file transfer receive using the file
transfer protocol selected in the Special menu. The received file is saved
in the default folder.

RECVEST path
The RECVDEST command changes the location of the default folder to
the folder or volume specified by the full pathname.

ANSWER none

The ANSWER command uses TeleFinder’s internal auto-answer routine to
scan for an appropriate modem connection response. If “Adjust BPS” is
turned on TeleFinder will adjust the serial port speed to the speed of the
modem connection. If a connection is established the flag is set to true,
otherwise it is set to false.

HANGUP none
The HANGUP command is the same as selecting Hangup from the
Special menu.

LOGFILE string

The LOGFILE command directs captured text to the file named by the
string. A new file will be created if necessary in the folder from which
TeleFinder was opened. If a file with the name given already exists in the
folder new data will be added to the end of that file.
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CAPTURE numeric
The CAPTURE command begins the capture of text data to the log file.
Use the number 0 to turn capture off, 1 to turn capture on.

CLOSELOG none
The CLOSELOG command stops capture and closes the current logfile.

TELEFINDER none

The TELEFINDER command attempts to link as a TeleFinder User to the
remote computer. This is the equivalent of selecting “Link as TF User”
from the terminals “Option” menu.

TELESERVER none

The TELESERVER command attempts to link as a TeleFinder Host to the
remote computer. This is the equivalent of selecting “Link as TF Host”
from the terminals “Option” menu. “All Files Access” is used.
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v ZModem
HMODEM
HMODEM
HMODEM

REK-RUEEAD

Hanyg Up

Change Password
session Time Choose the desired level of user access, enter a password if
i desired then click 0K to answer incoming calls.

Change ports...

Preferen

Show Partial Files... %\

-CRC 1K .
~CRC access the dialog shown below.

Remote Access Host

Remote Access
and Other Functions

Remote Access

Remote access is an easy way to provide password protected access to
files on your disks to other users of TeleFinder Pro. Callers can connect to
your Macintosh and download files just by dragging them to their own
disk. To provide remote access to your Macintosh select the
“Remote Access Host” menu item from the “Special” menu to

=———————— Remote Access Host ="iecF——————

ces...

Use Strings From >| Hayes U-Series Setup

User Access Permission [ Modem Audio

Access Password: D

@ “Public Folder” only access
O RAllow access to all files
( Users will be given access only to

the “Public Folder” )

Remote Access Host Dialog

The Remote Access Host dialog controls the modem settings to use,
whether or not the modem speaker is turned on, the level of access to
provide, and a password if desired. These items are explained below:

« Use Strings From> Click in this button to select which one of your
modem setups to use as a source of Modem settings. The strings from this
setup will be used to initialize and wake-up the modem. The settings will
be used set baud rate, flow control, AT pacing, adjust BPS, and use break.
Other items from the setup will be ignored.
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» Access Password: If a password is entered each caller must logon
using these characters as a password with their name as the user name.

» “Public Folder” Access: When this radio button is selected each
caller will only be able to see files within the folder named “Public
Folder” at the root level of the disk you opened TeleFinder from.

This folder will appear as a “Download Files” Icon on the caller’s
TeleFinder desktop. They will be able to download files found inside of it.

« Allow access to all files : When this button is selected each desktop
volume from your Macintosh will be shown on a caller’s desktop as a
“Download Files” Icon.

» Modem Audio: When this box is checked your modem’s speaker
will be turned on while connections are attempted, otherwise it will be
turned off at all time.

« OK/Cancel: Click in OK once you have made settings choices and
you are ready to accept incoming calls. Click in Cancel when you do not
want to accept further calls.

Using Remote Access

Remote access allows a caller to both send and receive files. They can
upload files to your Macintosh by dragging them to the “Send” Icon on
their TeleFinder desktop. Download files by dragging the file icon from
your folder to their own disk icon.

Use the “Chat Messenger” to communicate with the person using the
remote Macintosh. Chat allows you to send text messages back and forth.

Once connected to a Remote Access Host TeleFinder Pro’s mail menu

functions are dimmed. Electronic Mail and Conference functions are not
provided by the Remote Access Host.
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Other Functions

TeleFinder Pro has text editing, printing, disk management, and real-time
chat functions in addition to the features described in the previous
chapters.

Text Editing

In addition to the mail form, TeleFinder has a built-in text editor to create,
print and edit documents. Text documents can be opened while you are
connected to a Host, or from a local disk at any time. Documents opened
from a Host can be changed only after you have saved them to your own
disk.

Creating a New Document

To open an untitled document, select the “New Text” item from the File
menu. This will open an untitled window to compose text with. The text
editor is supported by the standard menu functions from the Edit and File
menus plus “Import Text” and “Special Import” functions.

Opening an Existing Document

Text documents can be opened from their icon or from the “Open” dialog.
To open a document from its icon, select the icon with the mouse and
choose “Open” from the file menu, or double-click on the icon.

To open a local document using the “Open” dialog, select “Open Text”

from the File menu then hilite the file’s name and click in the dialog’s
open button.
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Merging Text

Import Text and Special Import merge a text file into your Mail Message,
Conference Reply, or text documents. Import Text and Special Import are
undoable.

Import Text
When you import text to a document, the entire text from the file you open
is added at the insertion point, and will replace any selected text.

Special Import

Like Import Text, Special Import merges a text file into a document.
Special Import also strips unused control characters before merging the
text and removes hard-carriage returns from 80 column text to promote
better word wrapping.

Printing

You can print while still connected to the Host except during a file
transfer. If you print an especially long document while connected, the
Host may disconnect you after a few minutes due to inactivity.

To print a document use the Chooser Desk Accessory to select the printer
you want to use. Then select Page Setup from the File menu to select
options supported by your printer such as paper sizes, and wide or tall
output.

Select Print from the File menu to prepare and send the document to the
printer. Your document will be printed using the same Font that is used to
display it on the screen.
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Online chatting

The Chat Messenger is used for sending notes from you, to be displayed
on the screen of a TeleFinder Host. If someone is at the host Macintosh
they can send messages back to you. Chat cannot be used during
ZMODEM transfers.

O=——— (hat

Your message appears here when it has been
received by the host.

Repsonses are displayed in BOLD.

As messages begin to fill up this windoe, it

will scroll to each new message. You can stop
this automatic scrolling with the “Sroll Lock®
button. Y

Your message appears here when it has been received by

the

[Excrear | [O)scron Lock |

The Chat Messenger is accessed from the Mail menu.

Disk Management
TeleFinder supports many of the disk management functions you might
normally use the Finder for. You can:

« rename files and folders

» move icons to and from the desktop

» move files from one folder to another
« create new folders

« transfer to other applications

« use the Get Info dialog

All of the above functions operate similarly to the same functions in the
Finder.
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Selecting Icons from the Keyboard

You can select an icon using the keyboard by typing in the first few
characters of the file name, or by using the Up and Down arrows. The
Enter key will scroll a folder window to make a selected file visible. The
Return key is a short-cut for opening a selected icon. Home, End, PageUp
and PageDown are supported by folders windows for scrolling.

Renaming Documents and Folders

Select the icon, then click on its name. Use normal editing procedures for
changing the name. TeleFinder will not let you rename applications since
this will confuse the Finder. Document names are limited to 31 characters
in length, and folder names are limited to 27 characters.

Ejecting Disks

Drag the disk icon to the trash can to remove it from the desktop and close
its windows. This does not delete anything on the disk! If you want to
eject a disk from the internal drive without closing it, use the Command-
Shift-1 key combination.

Deleting Documents

You can delete a document or application by dragging it to the trash can.
TeleFinder empties the trash immediately after you confirm the action
with the OK button.

Creating Folders

To create a new folder, bring a local folder window to the front and select
the “New Folder” item from the File menu. This will create a new “Empty
Folder” in that window. If a folder named “Empty Folder” already exists,
you will be prompted with a dialog asking you for a different name.

New folders can be created on a TeleFinder BBS using this same
procedure only by users with appropriate access privileges.
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Advanced Modem Settings
and Trouble Shooting

This chapter will help you to properly configure your modem for use with
TeleFinder and adjust supplied modem settings for use in special
circumstances. '

Occasionally you may run across modems that will not connect with each
other, or poor quality telephone lines that are not suitable for data
transmission. You may have encountered similar problems with a Fax
machine that isn't able to send your page, or a bank ATM that
unexpectedly closes. Communications software like TeleFinder cannot be
adjusted to overcome all modem problems.

This chapter will address the problems you can overcome, and help point
out when it may not be a software or set-up problem, but rather a hardware
or telephone system problem.

The following pages give you procedures to deal with Dialing Failures,
Connection Failures and Communications Failures.

Configurations for High Speed Modems

TeleFinder has specific flow control, pass through, speed conversion and
modem response requirements. Other settings may need adjusting to
provide compatibility with other brands of modems.

You can create a custom configuration your modem for TeleFinder by
changing the Wake-up and Initialization strings to include commands that
will program your modem appropriately.

Configurations for most of the popular modems are already included in the
modem setups file. If your modem is not included in the file and one of
the other setups doesn't work with it, use the guidelines on the next page
to create your own modem strings.
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Flow Control

XON/XOFF flow control will prevent TeleFinder from communicating
normally with the BBS. If your modem has settings to adjust its flow
control you must use either “No Flow Control” or “Hardware Flow
control” ( RTS/CTS).

Using Hardware flow control requires a cable that assigns pin 1 (DTR)
from the Macintosh serial port to pin 4 (RTS) on the modem's RS-232
port. All other pin assignments are the same as the standard Macintosh
modem cable. This cable is required for all Hayes V-Series modems and
other V.42bis modems.

If you have programmed your modem to use flow control, select CTS/
DTR Flow Control from the modem menu.

XON/XOFF Pass Through

With high-speed modems there is usually a register or AT command that
defines how the modem responds to XON and XOFF characters. This
must be set to allow the modem to “pass-through” XONs and XOFFs.

If the modem does not pass XON and XOFF characters to TeleFinder you
will have severe problems connecting to the BBS, opening folders and
transferring files.

Speed Conversion

Many modems that are equipped with MNP or V.42 usually have an option
for changing the DTE speed after making a connection. This will be
called “Speed Conversion”, or “Speed Buffering” in your modem’s user
manual.

if you have “Speed Conversion” enabled on your modem, turn OFF the
Adjust BPS in the dialer. Speed conversion lets other modems connect to
yours at any common speed while your Macintosh communicates with the
modem at a fixed speed ( usually 9600 or 19.2K bps ).

When using Speed Conversion, hardware flow control is required.
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The Modem will not Wake-up or Dial the Number
If you are having trouble getting connected to the Host through the dialer,
try working through these procedures.

Please check the cables and baud rate.

TeleFinder Pro displays this alert when they are unable to “Wake-up” the modem.

: The Modem is not responding!

« If the modem does not respond - This means that your modem did not
respond with the “OK” response after TeleFinder sent it the wake-up or
initialization string.

Probable Causes of Dialing Failures

1) Either the wake-up or initialization string is too long;

2 ) There is a command in the string your modem doesn't understand;
3) The modem is turned off;

4) The cable between your Macintosh and the modem is loose;

5) The modem is not connected to the port you have selected;

6) The modem cannot communicate at the speed you have selected.

Possible Solutions to Dialing Failures

«  First, try changing both the “wake-up” and “initialization” strings to
simply “AT”. This will rule out invalid commands and strings that are too
long. If TeleFinder can dial can wake up the modem with this change the
problem is probably number 1 or 2, and not the others.

« Try power cycling (turning the modem off for several seconds, then on
again). Wait several seconds to before dialing. If it works now, it usually
means that the modem had an internal system crash. Put your original
strings in and try again.

« If you are still having trouble, power cycle again and try dialing at a
different speed, say 2400 or 1200 bps. Most modems have a preferred
communication speed, for 2400 bps modems it is 2400, 1200 bps modems
are 1200. High speed modems may prefer 9600 bps.
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+ If you think that the problem is in the command string, you can try
adding each command back in individually until you have a problem
again. If you have the manual for your modem handy, you can compare
each command in the strings to the modem's AT command summary for
verification. Leave the incorrect command out of the string and proceed
with dialing. .

» Unless you are using a Telebit modem, make sure that the “Use break
to reset” option is not selected. The break signal will confuse most
modems.

Connection Failures

Connection failures are those that occur when modems fail to connect to
each other. With high-speed modems this may occur if there is a
incompatibility in high-level modem protocols ( such as V.42 or MNP ). If
there is a connection failure, TeleFinder will usually display the “No
Computer Answered” message in the Call Progress field.

Probable Causes of Connection Failures

1) The value in the modem S7 register did not allow sufficient time to
complete the modem connection.

2) The Host had just completed a call, and is busy reinitializing the
modem.

3) A very poor quality telephone connection was made.

4) The modem used by the Host is incompatible with the modem that
TeleFinder/User is calling with.

5) The settings on one of the modem’s support high-level protocols (like
MNP), and do not permit “fallback” to a normal connection.
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Possible Solutions to Connection Failures

« The first two reasons are the most common. If you try calling the
number back after a minute and get a connection, it is likely that the host
was busy reinitializing after a previous call.

« If you still have a problem add “S7=60" or “S7=45" to your
initialization string to increase the time allowed for modems to connect.
Increasing this time may helps most with V.32 and other high speed
modems.

« If the connection failed because of a poor quality line, you may be able
to call back and make a connection on the second try. TeleFinder/User
may also report this problem as “Host failed to start the logon”.

This problem occurs more frequently over international telephone lines
and with some of the less expensive brands of modems. The long term
solution to this problem is to either upgrade your modem or telephone
service.

« The last two problems may be corrected by changing the Wake-up and
Initialization strings so that the modems connect on a common ground.
With an high speed modems be sure that the initialization string allows the
modem to fallback to lower level connections.

With MNP modems the “\N3” command provides auto-reliable mode to
permit connections to modems without MNP.

With the Telebit modems, “S50=3" will limit connections to 2400 bps or
lower.
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Communications Failures

Communications failures are those that prevent the accurate transfer of
data between the Host and TeleFinder/User. When this type of error
occurs you may not be able to transfer a file successfully, send mail, or
open remote folders.

Probable Causes of Communications Failures

1) A noisy phone connection that creates errors between modems.

2) Improper flow control.

3) One of the modems is trapping XON or XOFF characters.

4) Startup Documents ( INITs ) or local network traffic that interfere with
serial communications.

Possible Solutions to Communications Failures

» The most common source of persistent noise is the connection between
your phone line and the telephone system. This connection is usually
located within a telephone closet, or the phone company’s street box.

Your local phone company can test for this and correct it if present.

+ Improper flow control is most noticeable during ZMODEM file
transfers. If XMODEM transfers are free of retransmits and ZMODEM
transfers have several retransmits the flow control settings may be
incorrect in TeleFinder and the modem.

With modems that provide connections without an error correcting
protocol will automatically provide flow control for ZMODEM if “No
Flow Control” is selected. With modems that use MNP, V42 or another
error correcting protocol it is necessary to use hardware flow control.

+ If one of the modems fails to transmit XON and XOFF characters
TeleFinder will not be able to transfer files using XMODEM and several
desktop icons may be missing. In some cases the user may not be able to
connect.
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TeleFinder™ Pro

Verify that the modem settings you are using will allow you to send these
characters through your modem. For MNP modems “\Q0” is the
command that disables XON/XOFF; Telebit modems require
“S58=0S69=1"".

« Network traffic and Startup documents with background tasks may
prevent the TeleFinder from responding in a timely fashion, and in some
cases may interfere with the correct operation of the Macintosh serial
ports.

When this is a problem it produces a combination of the symptoms that
improper flow control and line noise do. If you suspect that thisis a
problem disconnect from AppleTalk file servers and/or disable your INITs
and try another connection with your Host.
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ossary of
TeleFinder Terms

Access Paths: A pathto a
folder that allows BBS users to
open that folder.

AT Command Set: A standard
set of commands used to control
basic modem functions such as
dialing the phone.

BBS: Bulletin Board System.
Software that provides, mail, file
transfer and message services.

Callback Security: A security
method that requires connections
to be made from a predeter-
mined phone number.

Comm Toolbox: Macintosh sys-
tem software that enables the
Macintosh to recognize more
than the two built in serial ports.
This can be added to System
6.0, and is standard in System
7.0.

Conferences Icon: Represents
and area for public messages.
You can read and write to folders
within these icons.

Download: Transferring a file
from the BBS to your computer.

Drop-Box Icon: The icon Tele-
Finder uses to represent write-
only access to another user's
mailbox. You can copy files into
it, but not read or browse its con-
tents.

File Recovery: When a partial
file is completed by re-sending
only the missing portion of the
file.

File Transfer: When a file is
copied from storage on one com-
puter to storage on another using
an agreed upon protocol.

Flow Control: Balancing the
rate of data transfer between de-
vices.

Handshaking: A process of ne-
gotiating a common protocol and
set of features.

Hardware flow control: Also
known as hardware handshake,
is flow control that uses the CTS
and RTS pins on the modem as
a means of controlling the stop
and start of data transfer. The
Macintosh serial ports use the
CTS and DTR pins for this pur-
pose.
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Host: The BBS Server software
that manages user access, mail,
and messages.

Logon: When your name and
password are verified, and Tele-
Finder determines a common
level of software capabilities.

- Mailbox Icon: The icon used to
represent the folder containing
files and messages which were
addressed to you.

Mail Outbox: This lets you pre-
pare and address mail and docu-
ments to send to other users
when you are not connected to
the BBS.

Message Thread: A collection of
messages on a related topic.
Also known as Message Base or
Message Index.

Modem Initialization Strings: A
set of commands that program
the modem to behave in a
specifc manner.

Online: When you are con-
nected to the BBS with your mo-
dem.

G-2 Glossary

Password: A string of 1-9 char-
acters that TeleFinder requires
before giving access to a user's
account.

Path: A sequence of volume,
folder and file names that de-
scribe the location of a file or
folder in a hierarical file system.

Protocol: A defined set of rules
that govern the exchange of data
in file transfers.

Remote Disk Icon: The Icon
TeleFinder uses to represent
“read-only" access to the folders
and files within it.

Send Icon: The icon used to
upload a file to be included in the
collection of public files.

Serial Port: An input/output
interface between the Macintosh
and external devices.

Session Time: The amount of
time you are allotted to spend on
the BBS during a single call.



Software flow control: Also
known as XON-XOFF flow, is
flow control that uses the XON
and XOFF characters as a
means of controlling the stop and
start of data transfer.

Sysop: System Operator. The
administrator of the BBS.

XMODEM: A file transfer proto-
col using either 8-bit checksum
or 16-bit CRC for error detection.

Upload: Transferring a file from
your computer to the BBS.

User Name: The name the BBS
knows you by.

V.22bis : The protocol used by
2400 bps modems to send and
receive data.

V.32: The standard protocol used
by 9600bps modems to send
and receive data.

V.42bis : A protocol used by mo-
dems to correct errors and com-
press data.

ZMODEM: A file transfer protocol

using 32-bit CRC for error detec-
tion.
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A,B,C
Addresses..........ccccuu..... 1-2,4-1,
4-4,4-5
AdjustBPS.................... 2-3
ANSWER ...................... 6-14
Auto Dialer .................... 1-3,2-3
BAUD .......ccccoeeee 6-13
BaudRate..................... 2-3, 6-3
BELL ..o 6-10
BREAK .........ccoeevvveeene. 6-12
Break Reset .................. 2-3

Call Progress ................ 2-4
CAPTURE...........c......... 6-15
Chaty s e 7-5,7-2
CLOSELOG.................. 6-15
Conferences ................. 2-7, 51
Configuring ................... 1-3, 8-1
Connection.................... 2-5
Connection Error........... 2-5
Connection Failure......... 8-4
Connection Name ......... 2-2
D,E,F

Default Destination........ 3-2,3-3
Desktop Icons ............... 1-5
DIaiNG! ocviversmiresssesionses 2-4,6-2,8-3
Drop Box.....cccccueeeeuieenne 2-7,3-2,
4-1,4-4,4-5

DUPLEX ....ccoeveeeeeee. 6-13
Electronic Mail .............. 4-1
END ..o, 6-11
FALSE ......ccoeviieee. 6-11

File Recovery................ 3-6

File Transfer.................. 3-1
FLOW . 6-13
Flow Control.................. 2-3,7-6,8-2

Index
G,H,|
GetInfo....ooveeieeeeenn, 2-9,3-2
GOTO ..o 6-11
HANGUP ..o 6-14
ICON ..ccoovvveennn.6-10
lcons im0 2-7,2-8
Import ... 7-4
K,L,M,N
Locate ........occovvviiinnnne 4-3
LOGFILE.............c......... 6-14
Logon SX.. ... 2-2, 6-1
Macro
Arguments .............. 6-8
Commands............. 6-10
Creating.................. 6-7
Elowr........ ... 6-7
Structure.................. 6-6
Syntax .......ccceeeeeee 6-8
Mail Form...................... 4-2
Mail Outbox................... 4-1,4-6
Mailbox .........ccccevvennnenne. 41
Merge ..ot 7-4
Message ........cccceeeennnes 1-9
Message Thread ........... 2-7, 51
Message Viewer ........... 5-2
Modem
Cable.......ccocuuen..... 8-2
Configuration........... 2-2
Initialization............. 2-3,8-3
Response ............... 8-3
Setup..veeeiie 2-1,4-7,7-1
Wake-up .......cccc...... 2-3
Navigate.........cccccceeeeee. 5-2
New Topic .......cccceeeenn. 5-5
New Uploads ................ 3-1
index i



Index

O,P,Q,R
Outbox ...coeoveeeeeecn 4-6
Password....................... 2-3, 6-2
Partial File.................... 3-6
PAUSE .......c.ooeeve. 6-11
Phone Number-.............. 2-2
Port Selection ............... 1-4
Printing .......oooiiiii 7-4
PROMPSEC ................. 6-11
PROMPT ....ovvveeeee 6-11
Receiving Files From...
"Info" window .......... 3-2
Mailbox ................... 3-2
Remote Disk ........... 3-2
Receive lcon ................. 3-3
RECVDEST ..........c...... 6-14
RECVMAC .................... 6-14
Remote Access............. 7-1
Reply S5 4-2,5-4
Requirements ............... 1-2
Retransmit .................... 3-5
S ’T! U )
Selecting Icons ............. 7-6
Sending Files To...
the host........... 2 3-1
another User........... 3-2, 4-4
SENDMAC ........ccc....... 6-14
SENDNAME ................. 6-12
SENDPASS.................... 6-12
SerialPort ..................... 1-4
Session Time ................ 2-6
SETCOMM ................... 6-13
SHOW ..o 6-10
SLOW ..., 6-12
Speed Conversion ........ 8-2
TELEFINDER ............... 6-15
TELESERVER .............. 6-15

ii index

Text Editing ........c..c....... 7-3

TF Outbox...........cccue.... 4-6

TF Pro Prefs ................. 1-2

TF Pro Partial Files ....... 3-6
Timeouts ........cccceveeeee.... 3-5
TRACE .....cooeeeeen 6-10
TRUE ..o 6-11
TYPE Lifeoeeainn. 6-12
UserList.......cccoevvvvnnnnnnn. 4-3
UserName.................... 2-3
User Preferences........... 1-4
VW, X,Y,Z

Verifying ......cccoooveeeeenn. 2-4
Wakeup.......ccceeevieennnn. 2-3,8-3
XMODEM..........c.......... 3-4,8-6
XON/XOFF ................... 8-2
ZMODEM........cccvveee.. 3-3,8-6



TeleFinder' Pro

TeleFinder was designed to fully support the Mac interface, not compromise it. In addtion to remote
access and file transfer, TeleFinder provides icons for your Personal Mailbox, Address Book, Mail
Outbox, and TTY Terminal. Sample TeleFinder BBS screen:

&€ File Edit Special Mail Windows 134 @2 ¥

Session Time Conferences
2 Conference

Time Connected 02:38
Time Remaining 42:22 .

Last Logon 6/3/91 10:17 AM
Host Time 6/3/91 1:33 PM

buest Mail =—————= rvice Bureau Forum

1 Mailbox Size

m How to Register a User Group.. 2K
m Read Me First! 2K
FA Froms Rusty T. 3/26/91 1K

Features Auto dialer

« Universal connectivity to any TeleFinder™ « Automatic logon to any TeleFinder'™ BBS.
or text terminal BBS. » Dialing directory to access up to 250

+ Macro language for logon scripting. services.

+ System 7 Savvy and Comm Toolbox « Link Service to a Macro.

compatible. » Built-in modem drivers for most popular

+ Host mode to let other Macs access your files modems, standard, non-standard and high-
with optional password protection. speed, V32/V42.

File Transfer Icon Interface TeleFinder BBS

Just drag a file's icon to your disk to upload and With TeleFinder BBS's Pro offers:
download! « Full Icon Interface

« ZMODEM - 32 « Electronic Mail

+ XMODEM - CRC/1K » Message Threads

+ XMODEM - Standard « Batch File Transfer

» ASCII Text capture. + Optional Callback security

TeleFinder is a Trademark of Spider Island Software, Manufactured and printed in the U.S.A.
© 1991 Spider Island Software
4790 Irvine Blvd, #105-347, Irvine CA 92720 Tel: (714) 669-9260




